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Legal Notices

Warranty
The only warranties for Hewlett Packard Enterprise products and services are set forth in the express
warranty statements accompanying such products and services. Nothing herein should be construed as
constituting an additional warranty. HPE shall not be liable for technical or editorial errors or omissions
contained herein.

The information contained herein is subject to change without notice.

Restricted Rights Legend
Confidential computer software. Valid license from HPE required for possession, use or copying. Consistent
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Technical Data for Commercial Items are licensed to the U.S. Government under vendor's standard
commercial license.
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© Copyright 2015 Hewlett Packard Enterprise Development LP

Trademark Notices
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Microsoft® and Windows® are U.S. registered trademarks of Microsoft Corporation.

UNIX® is a registered trademark of The Open Group.

This product includes an interface of the 'zlib' general purpose compression library, which is Copyright ©
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Documentation Updates
The title page of this document contains the following identifying information:

l Software Version number, which indicates the software version.
l Document Release Date, which changes each time the document is updated.
l Software Release Date, which indicates the release date of this version of the software.
To check for recent updates or to verify that you are using the most recent edition of a document, go to:
https://softwaresupport.hp.com

This site requires that you register for an HPE Passport and sign in. To register for an HPE Passport ID, go
to: https://hpp12.passport.hpe.com/hppcf/createuser.do

Or click the Register link at the top of the HPE Software Support page.

You will also receive updated or new editions if you subscribe to the appropriate product support service.
Contact your HPE sales representative for details.

Support
Visit the HPE Software Support Online web site at: https://softwaresupport.hp.com

This website provides contact information and details about the products, services, and support that HPE
Software offers.

HPE Software online support provides customer self-solve capabilities. It provides a fast and efficient way to
access interactive technical support tools needed to manage your business. As a valued support customer,
you can benefit by using the support website to:
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l Search for knowledge documents of interest
l Submit and track support cases and enhancement requests
l Download software patches
l Manage support contracts
l Look up HPE support contacts
l Review information about available services
l Enter into discussions with other software customers
l Research and register for software training
Most of the support areas require that you register as an HPE Passport user and sign in. Many also require a
support contract. To register for an HPE Passport ID, go to:

https://hpp12.passport.hpe.com/hppcf/createuser.do

To find more information about access levels, go to:

https://softwaresupport.hp.com/web/softwaresupport/access-levels

HPE Software accesses the HPE Software to explore Enterprise Solutions that meet your business needs,
and a full list of Enterprise Software Products and Services. The URL for this website is
https://www.hpe.com/us/en/software.html.

About this PDF Version of Online Help
This document is a PDF version of the online help. This PDF file is provided so you can easily print multiple
topics from the help information or read the online help in PDF format. Because this content was originally
created to be viewed as online help in a web browser, some topics may not be formatted properly. Some
interactive topics may not be present in this PDF version. Those topics can be successfully printed from
within the online help.
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Chapter 1: Customization Editor Guide
Welcome to theCustomization Editor User Guide. This guide explains how to use Customization Editor as
part of HPE EnterpriseMaps (HPE EM).

This guide contains the following chapters:

l "Overview " on page 8
Provides an overview of themain features of Customization Editor.

l "Getting Started " on page 16
Describes the installation of themain features, and shows you how to create an extension
inCustomization Editor.

l "Manipulating Artifact Types " on page 22
Explains how to create, modify and delete artifacts and packages using Customization Editor.

l "Creating and Using Components " on page 29
Shows how to create and use custom components in Customization Editor .

l "Modifying Taxonomies " on page 31
Shows how to build andmodify taxonomies for an extension project in Customization Editor.

l "Deploying Extensions " on page 32
Instructions on how to deploy extensions created in Customization Editor.

l "Views " on page 37
Explanation of each view in Customization Editor.

l "Dialog Boxes " on page 46
Dialog boxes reference.

l "LocalnameNaming Rules " on page 55
Naming strategies for database tables and columns.
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Chapter 2: Customization Editor 
HPE EMCustomization Editor is a set of HPE EMWorkbench features that enable you to edit the underlying
System DataModel (SDM) configuration of an installation of HPE EM.

With the introduction of HPE EM 1.00, WebGUI customization was decoupled from SDM customization.
Having applied an SDM extension, HPE EM administrators must configure the UI visibility of
artifacts/properties in the webGUI using theAdministration > Customizemenu. This is no longer part of
the HPE EMWorkbench tool set.

This chapter introduces Customization Editor in the following sections:

l "HPE EMWorkbench Suite " below
l "Overview " below
l "User Interface " on the next page
l "SDM Elements " on page 13

HPE EMWorkbench Suite 
HPE EMWorkbench is a suite of editor tools enabling you to customize your deployment of HPE EM.

HPE EMWorkbench consists of the following editor tools, distributed as a single Eclipse development
platform:

l Customization Editor
Customizes the underlying System DataModel (SDM) within HPE EM.

l Taxonomy Editor
Customizes the taxonomies used to categorize artifacts in HPE EM.

l Assertion Editor
Customizes the conditions applied by your business policies within HPE EM.

l Report Editor
Customizes report definitions for use with HPE EM.

Overview 
HPE EM is distributed with a preconfigured datamodel. For typical deployment scenarios, themodel should
be customized to fit an organization-specific environment.

HPE EMCustomization Editor provides amechanism to customize themodel, implement those changes,
and keep them isolated in a so-called extension package that can then be re-applied during a re-installation or
upgrade of HPE EM.

To customize HPE EM, follow this process:

1. Create an extension project.
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For details, see "Creating an Extension Project " on page 19.
2. Modify the datamodel.

For details, see the following:
l "Manipulating Artifact Types " on page 22

l "Modifying the Properties of an Artifact Type " on page 23

l "Creating and Using Components " on page 29

l "Modifying Taxonomies " on page 31

3. Deploy the customization to HPE EM.
For details, seeDeploying Extensions.
Be very careful whenmodifying artifacts that already have instances in the repository. For example, a
new installation already contains the person artifact administrator. Removing properties from an artifact
type with instances, or adding a new required property without a default value, may cause instability in
HPE EM. Customization Editor should prevent this if the HPE EM server is running duringmodification.

User Interface 
The default Extension perspective is split into a number of sections with menu options across the top.

The perspective consists of the following elements:

l Project Explorer
The tree view of the SDM configuration represented by your project.
For details, see "Extension Explorer " below.

l Server Explorer
The view listing HPE EM server connections to HPE EMWorkbench.
For details see, "Server Explorer " on page 13.

l Editor Views
Themain area of the perspective contains editor views of project elements. You can openmultiple editors.
The functionality of each editor varies depending on the project element.
For details, see "Views " on page 37.

l Information Views
Messages and search results open their own views.
For details, see "Views " on page 37.

l Menu Items
The standard Eclipsemenu options plus additional HPE EMWorkbench options.
For details about the additional options for Customization Editor, see "MenuOptions " on page 12.

Extension Explorer 
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The Extension Explorer, as shown in“Extension Explorer View”, represents a tree view of the extension
project that you are currently working with. It includes all the elements from extensions that it depends on as
well.

The tree is split into the extension root and five branches representing different elements of your extension.

Double-click an item in the tree to open the relevant editor, ot to open or close a branch.

For details about each editor, see "Views " on page 37.

Right-click an element to open a context menu that contains options for the element.

Each element and its contextual functionality is described in the following sections:

l "Extension Name " below
l "Artifact Types " below
l "SDM Details " on the next page
l "User Interface " on the previous page
l "Taxonomies " on page 15
l "Project Editor " on page 40

Extension Name 
The extension name is the root element of the project.

The context menu contains the option toBuild Extension, which creates a jar file that contains your
extension. This extension is ready to import to HPE EM.

For deployment details, see "Deploying Extensions " on page 32.

Artifact Types 
The Artifact Types branch contains the artifact types organized into a hierarchical structure reflecting the
System DataModel (SDM). Each element withinArtifact Types is a type of artifact or artifact package.

Caution: HPE EM separates the SDM into twomodels, public and system. Customization Editor hides
system artifacts, preventing you frommodifying them.

Tip: An artifact package is an artifact type that serves as a group of other artifacts. They do not have
instances in the repository and just serve to organize a hierarchy of artifact types in the SDM.

For details, see "Artifacts " on page 14

The context menu for the Artifact Types branch contains the following functionality:

l New Artifact Type orPackage
Creates an artifact type as described in "Creating an Artifact Type or Package " on page 22.

l Open Artifact Type orPackage
Opens the artifact editor for the selected element with the name of the element as the editor title.
For details, see "Artifact Editor " on page 37

l Deprecate Artifact Type or Package

Customization Editor User Guide
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Deactivates the artifact type in the extension project and hides it in the HPE EMUI.
l Undeprecate Artifact Type orPackage
Reactivates a deprecated artifact type in the extension project.

l Delete Artifact Type orPackage
Removes the artifact type from the extension project.

SDM Details 
The SDMDetails branch contains two element types described in the following sections:

l "Property Descriptors " below
l "Property Groups " on page 15
HPE EM separates the SDM into twomodels, public and system. Customization Editor shows properties
and property groups used by system artifacts, but prevents you frommodifying them.

Property Descriptors 

Property descriptors are the attributes of artifact types.

For details, see "Properties " on page 14.

In the Extension Explorer, properties are divided into the following branches:

l Primitive Property Descriptors
l Relationship Property Descriptors
l Taxonomy Property Descriptors
Each property type branch contains one context menu option: New Property.

For details, see "Creating a Property " on page 27.

Each property type branch contains a list of the properties of that type.

The context menu for properties contains the following options:

l Open Property
Opens the property editor for the selected element with the name of the element as the editor title.
For details, see “"Property Editor " on page 42”.

l Deprecate Property
Deactivates the property in the extension project and hides it in the HPE EMUI.

l Undeprecate Property
Reactivates the deprecated property in the extension project.

l Delete Property
Removes the property from the extension project.

l Find Usage
Opens a search view displaying all the artifacts and property groups containing this property.
For details, see "Search View " on page 44.

Property Groups 
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Property groups are sets of properties that can be added collectively to an artifact type.

For details, see "Property Groups " on page 15.

The context menu of the Property Group branch contains one option: New Property Group.

For details, see "Creating a Property Group " on page 28.

The context menu for each property group contains the following options:

l Open Property Group
Opens the property group editor for the selected element with the name of the element as the editor title.
For details, see "Property Group Editor " on page 44.

l Delete Property Group
Removes the property group from the extension project.

l Find Usage
Opens a search view displaying all the artifacts that contain this property group.
For details, see "Search View " on page 44.

Menu Options 
Themenus in HPE EMWorkbench are standard Eclipsemenus, with the addition of specific functionality for
HPE EMWorkbench editors.

The additional menu options for Customization Editor include:

l File > New > HPE Extension Project
Create a new project, as described in "Creating an Extension Project " on page 19.

l File > New > Artifact Type
Create an artifact type, as described in "Creating an Artifact Type or Package " on page 22.

l File > New > Artifact Package
Create an artifact package, as described in "Creating an Artifact Type or Package " on page 22.

l File > New > Property
Create a property, as described in "Creating a Property " on page 27.

l File > New > Property Group
Create a property group, as described in "Creating a Property Group " on page 28.

l File > New > Component
Create a component, as described in "Creating a Component " on page 29.

l File > New > Task
Create a task, as described in "Creating a Task " on page 29.

l Navigate > Go To > Open Artifact
Open an artifact editor, as described in "Artifact Editor " on page 37.
The keyboard shortcut Ctrl+Alt+A also performs this function.

l Navigate > Go To > Open Property
Open a property editor, as described in "Property Editor " on page 42.
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The keyboard shortcut Ctrl+Alt+P also performs this function.
l Navigate > Go To > Open Property Group
Open a property group editor, as described in "Property Group Editor " on page 44.
The keyboard shortcut Ctrl+Alt+R also performs this function.

l Search > Search
Open a search dialog box, as described in "Searching the Extension " on page 21.

l Help > Dynamic Help
Access context-sensitive help, directing you to the relevant section of this document based on the active
view in Customization Editor.

Server Explorer 
The Server Explorer displays the HPE EM servers connected toWorkbench. The functionality is shared by
all the HPE EMWorkbench editors.

Right-click a server in the Server Explorer to open the context menu described in the “Server Explorer
Context MenuOptions” table below.

Server Explorer Context Menu Options

Option Function

New Server Add a server for downloading assertions and taxonomies (Assertion Editor, Taxonomy
Editor, and Customization Editor).

Remove
Server

Delete a server from the Server Explorer.

Download
Taxonomy

Download a taxonomy from a platform server (Taxonomy Editor and Customization
Editor).

Download
Assertion

Download assertions from a platform server (Assertion Editor).

Download
Report

Download reports from a reporting server (Report Editor).

Properties View and edit the server name, URL, username, and password.

SDM Elements 
Customization Editor manages four types of entities in the SDM configuration of HPE EM.

These entity types are described in the following sections:

l "Artifacts " on the next page
l "Properties " on the next page
l "Property Groups " on page 15
l "Taxonomies " on page 15
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Artifacts 
Artifacts are the basic building blocks of SOA. Every entity in the repository is an instance of an artifact. Each
type of artifact is defined by an artifact type in the SDM. Artifact types are further categorized into artifact
packages. These packages are abstract artifact types that do not have instances in the repository but instead
define groups of artifacts.

You can explore artifact types and packages in the Artifact Types branch of the Extension Explorer.

For details, see “"Artifact Types " on page 10”.

For artifact type procedures, see "Manipulating Artifact Types " on page 22.

Properties 
Properties are the attributes of artifacts, the labels that distinguish one instance of an artifact from another.
For example, all artifact instances have the name property, but every artifact has a different name.

There are three categories of property:

l Primitive Properties
The basic labels for artifacts such as name and description.
Basic properties are of the following types:

Property Type Description

addressPropertyType A full postal address.

booleanPropertyType True or false.

categoryBagPropertyType A taxonomic categorization.

dailyIntervalPropertyType A time period with a start and end day, for exampleMonday to
Friday.

dateTimePropertyType A specific date and time.

doublePropertyType A double precision floating point number.

encryptedPasswordPropertyType An encrypted password.

identifierBagPropertyType A taxonomic identification.

integerPropertyType An integer number.

nameUrlPairPropertyType A URLwith an optional name assigned.

nameValuePairPropertyType A name and value pair.

plainTextPropertyType One-line text, suitable for properties such as name.

textareaPropertyType Multi-line text, suitable for properties such as description.

l Relationship Properties
The nature and direction of a relationship with another artifact such as ImplementationOf.

Customization Editor User Guide
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l Taxonomy Properties
The categories used to define an artifact based on taxonomies such as the High category in the Failure
Impact taxonomy.

You can explore properties in the SDMDetails branch of the Extension Explorer.

For details, see “SDMDetails”.

For property procedures, see "Modifying the Properties of an Artifact Type " on page 23.

Property Groups 
You can organize properties into groups, and add them to artifacts collectively instead of individually. For
example, you can organize name, address, and telephone number into a contact details property group. Then,
whenever a new artifact type is created that represents a person, the group can be added to it instead of the
individual properties.

You can explore property groups in the SDMDetails branch of the Extension Explorer.

For details, see “SDMDetails”.

For property group procedures, see "Modifying the Properties of an Artifact Type " on page 23.

Taxonomies 
Taxonomies are categorization groups, each of which contain a set of values within a single category. For
example, office location can be a taxonomic group containing a set of values representing each office in an
organization.

You can explore taxonomies in the Taxonomies branch of the Extension Explorer.

For details, see “Taxonomies”.

For taxonomy procedures, see "Modifying Taxonomies " on page 31.
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Chapter 3: Getting Started 
You can use Customization Editor to create extensions to the core HPE configuration. The core configuration
itself is not modified. Instead, HPE EM includes a utility for adding extensions to the configuration.

This chapter contains the following sections:

l "Installing HPE EM Workbench" below
l "SSL Configuration" on page 18
l "Creating an Extension Project " on page 19
l "Searching the Extension " on page 21
l "SavingModifications " on page 21

Installing HPE EM Workbench
HPE EM is an Eclipse development platform distributed as a zip file, hpe-em-workbench-3.10-win64.zip.

Note: HPE EM requires Java SE Development Kit (JDK) 1.8.0 (64 bit version only) or higher. Youmust
include the path to this version of the JDK in the JAVA_HOME environment variable.

To install Enterprise Maps as a new Eclipse platform:

l Extract the archive to your required location, referred to in this document as WB_HOME.

Note: The pathmust not be longer than 97 characters.

To Start HPE EM:

l ExecuteWB_HOME/workbench/start.exe.
The first time you start HPE EMWorkbench, the welcome screen opens.

Select one of the options to open one of the editor tools, start a new editing project, or view the documentation
set.

You can return to the welcome screen from any of the editor tools by selectingHelp > Welcome from the
menu options.

Tip: By default, HPE EMWorkbench runs in 'normal' mode which prevents users from uploading system
taxonomies (IDs start with uddi:systinet.com:soa:model:taxonomies) and the Report Editor
.rptlibrary file to HPE EM servers. If you need to work with system taxonomies or want to upload the
.rptlibrary file you can switch HPE EMWorkbench into 'admin' mode.

Caution: Be extremely careful when working with system taxonomies, HPE EM uses some hard-coded
values from system taxonomies. Changing or removing themmay cause errors.

To Switch HPE EM Workbench to Admin Mode
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1. Open WB_HOME/configuration/config.iniwith a text editor.
2. Add mode=admin to config.ini.
3. Restart HPE EMWorkbench.

Tip: HPE EnterpriseMaps is memory-intensive. If you experience performance issues, HPE
recommends increasing thememory allocation.

To increase the memory allocation for HPE Enterprise Maps:

1. Open WB_HOME/workbench/start.ini for editing.
2. Set these new values:

l -Xms128m

l -Xmx1024m

3. Save your changes.
4. Restart HPE EMWorkbench.

Tip: HPE EnterpriseMaps downloads from HPE EMmay time out. If you experience issues, HPE
recommends increasing the time out.

To increase the time out for HPE Enterprise Maps:

1. Open WB_HOME/workbench/start.ini (or eclipse.ini for stand-alone installation) for editing.
2. Set the new value:

-Dorg.em.platform.rest.Client.timeout=200000

The value is in milliseconds with a default value of 120000 (2minutes).
3. Save your changes.
4. Restart HPE EMWorkbench.

Tip: HPE EMWorkbenchmay fail to store saved credentials of servers. In such cases, HPE
recommends clearing the secure storage.

To reset the secure storage for Enterprise Maps server credentials:

1. In EnterpriseMaps, go toWindows > Preferences > General > Security > Security Storage >
Contents tab.

2. Click root nodeDefault Secure Storage and then click Delete button.

Customization Editor User Guide
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3. Restart theWorkbench.

SSL Configuration
By default, HPE EMWorkbench trusts all HPE EM server certificates. Youmay want HPE EMWorkbench
to verify HPE EM certificates.

To Verify HPE EM Server Certificates:

l Add the following options to WB_HOME/workbench/start.ini:

-Dcom.hp.em.security.ssl.verifyCert=true
-Djavax.net.ssl.trustStore=USER_TRUSTSTORE
-Djavax.net.ssl.trustStorePassword=TRUSTSTORE_PASS
-Djavax.net.ssl.trustStoreType=TRUSTSTORE_FORMAT

If HPE EM is configured for 2-way SSL, youmust provide HPE EMWorkbench certificates to HPE EM.

To Provide HPE EM Workbench Client Certificates to HPE EM:

l Add the following options to WB_HOME/workbench/start.ini:

-Djavax.net.ssl.keyStore=USER_KEYSTORE
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-Djavax.net.ssl.keyStorePassword=KEYSTORE_PASS
-Djavax.net.ssl.keyStoreType=KEYSTORE_FORMAT

Creating an Extension Project 
The first step in customizing your HPE EM installation is to create an extension project in the Customization
Editor. This is the workspace where youmake all your modifications.

The symbol ≽ supports the separation of projects based on their type. The following extension project types
are supported:

l model
Extensions for changes to the datamodel.

l code
Extensions for custom components.

l mixed
Combinedmodel and code extensions.

HPE Software recommends separating extensions into separate types because HPE EM does not guarantee
backward compatibility for the Java API. This may make it difficult to migrate custom components to newer
versions.

model extensions are easily migrated by opening them in the latest version of Customization Editor, building
a new extension and redeploying them.

To create an extension project:

1. In themenu, select File > New > Project.
The New Project wizard opens.

2. ExpandHPE EM Extension Project, and click Next.
3. In the New Extension Project dialog box, select either a local or remote EM installation and add the

parameters you want.
For parameter descriptions, see "New Extension Project: Specify HPE EM Server Installation " on page
48.

Note: Creating an extension project based on a remote installation of EM, is not available in
Production installationmode.

4. Click Next to select or create a server.
If no servers are currently configured the dialog continues to Step 6.

5. Do one of the following:
l Select Create a New Server, and then click Next.
Continue to Step 6.

l Select Use an Existing Server, select the server from the list and input its credentials, and then
click Next.
Continue to Step 7.

6. In the New Server dialog box, add the parameters you want, and then click Next.

Customization Editor User Guide
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For parameter descriptions, see "New Extension Project: New Server " on page 48.
7. Do one of the following:

l Select Create a New Extension Project from Scratch to create an empty extension containing no
elements at all.
Click Next.

l Select Edit an Existing Extension to open an existing extension for modification.
Select an extension from the extension folder, or useAdd Extension to select one from another
location.
Click Next to continue to Step 10.

l Select Create a New Extension from an Existing One to use an existing extension as the basis of
a new one.
Select an extension from the extension folder or useAdd Extension to select one from another
location.
Click Next.
If you use this option, youmust remove the existing extension from the extensions folder before you
deploy the new modified extension.

8. In the Create Extension or Project dialog box, add the parameters you want, and then click Next.
For parameter descriptions, see "New Project: Create a New Extension " on page 49.

9. In the Add Dependencies dialog box, optionally select or add extensions to depend on, and then click
Next.

10. In the HPE EM Extension Project dialog box, add the parameters you want, and then select available
projects to reference.
Adding referenced projects enables you to use assertions or taxonomies from the referenced projects
without the need to copy themmanually to the extension project.

11. Click Finish to open the project.
In the Platform perspective, the Project Explorer now displays a view of your extension that contains not only
the elements contained in your extension project but all the elements from any other extensions that your
project depends on.

For details about the contents of your extension project, see "Extension Explorer " on page 9.

Sharing an Extension Project 
HPE EM enables the sharing of an extension project in the CVS repository.

To share an extension project:

1. In Extension Explorer, right-click the project you need to open its context menu, and select Team >
Share Project to open theShare Project dialog box. For details, see "Share Project " on page 54.

2. Enter the required parameters and click Finish.
The project is published to the CVS repository.
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Referencing Other HPE EMWorkbench Projects 
You can include assertions and taxonomies from an Assertion or Taxonomy Project in your current Extension
Project.

To reference an Assertion or Taxonomy Project:

1. From the platform perspective, right-click your extension project and select Properties to open the
Preferences dialog box, and then select Project References to view projects available to reference.

2. Select the projects you want to reference and click OK.
The assertions or taxonomies from the referenced project are copied to your extension project.

Saving Modifications 
As youmodify an entity in your extension project, the tab label of the entity editor is marked with an asterisk
(*).

To save your changes to the project, select File > Save from themenu, or use keyboard shortcut Ctrl+S.

If you close an editor or the application with unsaved changes, you are prompted to save these changes.

Your modifications aremade to your extension project and not to the configuration of HPE EM. To deploy
your customization to HPE EM, see "Deploying Extensions " on page 32.

Searching the Extension 
The Customization Editor contains a customized search function, which enables you to find entities in your
extension project.

To search your extension project:

1. From themenu, select Search > Search.
The Search dialog box opens.

2. In the SDM Search tab of the Search dialog box, add the parameters for your search.
For parameter descriptions, see "Search " on page 53.

3. Click Search.
The search results appear in the Search view.
For details, see "Search View " on page 44.

Customization Editor User Guide
Chapter 3: Getting Started 

HPE EnterpriseMaps (3.10) Page 21 of 55



Chapter 4: Manipulating Artifact Types 
You can use Customization Editor to create, modify, and delete artifact types and packages in your extension
project. You can also change the format of artifact pages in the HPE EMUI.

HPE EM separates the SDM into twomodels, public and system. Customization Editor hides system
artifacts, preventing you frommodifying them.

For more details about artifact types and packages, see "Artifacts " on page 14.

The chapter explains the following procedures:

l "Creating an Artifact Type or Package " below
l "Modifying the Attributes of an Artifact Type " on the next page
l "Modifying the Properties of an Artifact Type " on the next page
l "Mapping an Artifact Type to a Registry " on page 24
l "Example: Adding the Department Property to Services " on page 25

Creating an Artifact Type or Package 
Customization Editor enables you to create a new artifact type or package in your extension project.

To create an artifact type or package:

1. Do one of the following:
l From themainmenu, select New > Artifact Type orPackage.

l In the Extension Explorer, open the context menu of an artifact package branch and select New
Artifact Type orPackage.

The New Artifact Type or New Artifact Package dialog box opens.
2. In the dialog box, add the artifact parameters you want.

For parameter descriptions, see "New Artifact: Create " on page 46.
For localname naming conventions, see "LocalnameNaming Rules " on page 55.

3. Do one of the following:
l Click Finish to create the artifact type or package and exit the dialog box.

l Click Next and continue to Step 4 to set database parameters.

4. In the dialog box, add the database parameters you want.
For parameter descriptions, see "New Artifact: Database Settings " on page 47.

5. Click Finish to create the artifact type or package.
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Modifying the Attributes of an Artifact Type 
Customization Editor enables you to edit themain attributes of artifact types.

To edit the attributes of an artifact type:

1. Open the artifact editor and select theOverview tab.
2. In the Overview tab, make any changes you want.

You cannot change the local name of the artifact if the extension project is in productionmode.
For a description of the Overview tab, see "Artifact Editor " on page 37.

3. Press Ctrl+S to save your changes.

Modifying the Properties of an Artifact Type 
Themain attributes of artifact types are properties. You canmodify these properties, add them individually, or
add them as a group within the artifact editor.

To add or modify the properties and property groups of an artifact type:

1. Open the artifact editor and select theProperties tab.
2. In the Properties tab, make any changes you want.

For a description of the Properties tab, see "Artifact Editor: Properties Tab " on page 38.
3. Press Ctrl+S to save your changes.
You can change the local name of the property descriptor defined in the current extension project.

To change the local name of a property descriptor:

1. From the treemenu of Extension Explorer, expandSDM Details > Property Descriptors.
2. Browse for the descriptor you want, and double-click to open theOverview view.
3. In the Local Name field, enter the parameters you require, and then save your changes.
You can also change the cardinality of an artifact defined in the current extension project.

Note: You cannot change the local name of the property descriptor if the extension project is in
productionmode.

To change the cardinality of an artifact type:

1. Browse for the artifact you need and open the Editor view, and then switch to theProperties tab.
2. In theCardinality field, click to open the drop-downmenu, and select the cardinality you need.

Note: For taxonomic properties, the cardinality affects the way the property displays in the HPE EM
UI.

l Required taxonomic properties display as anAdd Category function.

l Optional taxonomic properties display as a drop-downmenu.

Customization Editor User Guide
Chapter 4: Manipulating Artifact Types 

HPE EnterpriseMaps (3.10) Page 23 of 55



l Multiple taxonomic properties display as a list box.

Tip: You cannot change the cardinality of an artifact if the extension project is in productionmode.

You can also change the direction of relationship of a property descriptor which is defined in the current
extension project.

To change the direction of a relationship property descriptor:

1. In Extension Explorer, expandSDM Details > Property Descriptors > Relationship Property
Descriptors and double-click the descriptor you need to open its Editor view.

2. In theDirection field, click the link next to Inverse Display Name to toggle the relationship between
incoming or outgoing, and then save your changes.

HPE EM also enables you tomodify the taxonomical properties of an artifact type.

To modify the taxonomical properties of an artifact:

1. In Extension Explorer, browse for the artifact you need and open its Editor view, and then switch to the
Properties tab.

2. In the Properties window, click New to open theNew Property dialog box, and select Taxonomy
Property, and then click Next.
TheNew Taxonomy Property dialog box opens. For details, see "New Property: Taxonomy " on page
51.

3. Enter general parameters and in the Taxonomy Name field, do one of the following:
l Click Browse to browse for and select from a list of available taxonomies.

l Click Create to open the Create a New Taxonomy dialog box. For details, see "New Taxonomy " on
page 52.

4. Enter the parameters you want and click Finish.
The created taxonomy is now visible in theNew Taxonomy Property dialog box.

5. Click Finish.

Mapping an Artifact Type to a Registry 
You canmap artifacts in HPE EM to registry entities in a UDDI registry.

The artifact types listed in “Predefined Registry Mapping” have predefinedmappings to registry and cannot be
amended.

Predefined Registry Mapping

SDM Artifact UDDI Entity Direction

Organizational Unit BusinessEntity Bi-directional

Business Service tModel Bi-directional

Implementation Artifacts Business Service Bi-directional

Endpoint BindingTemplate Bi-directional
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Themapping of an artifact to a registry entity is illustrated in “Registry Mapping”.

To add or modify artifact type mappings to registry entities:

1. Open the artifact editor and select theRegistry Mapping tab.
2. In the Registry Mapping tab, make any changes you want.

For a description of the Registry Mapping tab, see "Artifact Editor: Registry Mapping Tab " on page 39.
For details on how to add an artifact mapping, see "Adding a Registry Mapping for an Artifact Type "
below
For details on how to add a property mapping, see "Adding a Registry Mapping for a Property " below.

3. Press Ctrl+S to save your changes.

Adding a Registry Mapping for an Artifact Type 
You canmap artifact types to registry entities.

To add an artifact mapping:

1. Open the Artifact Editor and select theRegistry Mapping tab.
2. In the Artifact Mapping pane, click Add.

The New Artifact Mapping dialog box opens.
3. In the New Artifact Mapping dialog box, add the parameters you want.

For parameter descriptions, see "Registry Mapping: New Artifact Mapping " on page 52.
4. Click Finish to add themapping.

Adding a Registry Mapping for a Property 
You canmap properties to registry entity keyed references.

To add a property mapping:

1. Open the Artifact Editor and select theRegistry Mapping tab.
2. In the Property Mapping pane, click Add.

The New Property Mapping dialog box opens.
3. In the New Property Mapping dialog box, add the parameters you want.

For parameter descriptions, see "Registry Mapping: New Property Mapping " on page 53.
4. Click Finish to add themapping.

Example: Adding the Department Property to
Services 
In this example, you add a new taxonomic property, department, to the service artifact.

To follow this example, youmust first do the following:
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l In Customization Editor, create a new extension dependent on the core extension, as described in
"Creating an Extension Project " on page 19

l In Taxonomy Editor, create a new department taxonomy and deploy it to HPE EM, as described in the
"Example: Creating and Publishing a Department Taxonomy" section of theHPE EnterpriseMaps
Taxonomy Editor Guide.

To add the department property to services:

1. Open theService editor and select theProperties tab.
2. In the Properties segment, click New.
3. Select Taxonomy Property and click Next.
4. Input Department as theDisplay Name.
5. For the Taxonomy, click Browse and import theDepartments taxonomy.
6. Press Ctrl+S to save your changes to the business service artifact type.
7. Deploy your extension, as described in "Deploying Extensions " on page 32
8. Start your installation of HPE EM
Add the property to the artifact in the user interface.
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Chapter 5: Manipulating Properties 
Customization Editor enables you to create, modify, and delete properties and property groups in your
extension project.

Caution: HPE EM separates the SDM into twomodels, public and system. Customization Editor shows
properties and property groups used by system artifacts, but prevents you frommodifying them.

For more details about properties and property groups, see "Properties " on page 14 and "Property Groups " on
page 15.

This chapter describes the following procedures:

l "Creating a Property " below
l "Modifying a Property " on the next page
l "Creating a Property Group " on the next page
l "Modifying a Property Group " on the next page
In addition, "Manipulating Artifact Types " on page 22 includes the following procedures related to properties:

l "Modifying the Properties of an Artifact Type " on page 23
l "Mapping an Artifact Type to a Registry " on page 24

Creating a Property 
You can create properties individually and then add them to artifact types later.

To create a property:

1. Do one of the following:
l From themenu, select File > New > Property.

l In the Extension Explorer, open the context menu for the Property Descriptors branch, select New
Property, and then select the property type.

l In the Extension Explorer, open the context menu for a property type branch and select New Type
Property to create a property of that type.

The New Property dialog box opens.
2. In the New Property dialog box, add the property parameters you want.

For parameter descriptions of each property type, see the following:
l "New Property: Primitive " on page 50

l "New Property: Relationship " on page 50

l "New Property: Taxonomy " on page 51
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For localname naming conventions, see "LocalnameNaming Rules " on page 55.
3. Click Finish to create the property.

Modifying a Property 
Customization Editor enables you tomodify properties.

To edit a property:

1. Open the Property Editor.
2. In the Property Editor, make any changes you want.

For a description of the Property Editor, see "Property Editor " on page 42.
3. Press Ctrl+S to save your changes.

Creating a Property Group 
Many artifact types share sets of the same properties. It is useful to create groups of properties and add these
to artifact types instead of adding each property individually.

To create a property group:

1. Do one of the following:
l From themenu, select File > New > Property Group.

l In the Extension Explorer, open the context menu for the Property Groups branch, and select New
Property Group.

l Open the Artifact Editor and select the Properties tab. In the Property Groups pane, click New to
create a new property group as a set of attributes for an artifact type.

The New Property Group dialog box opens.
2. In the New Property Group dialog box, add the parameters you want.

For parameter descriptions, see "New Property Group " on page 51.
3. Click Finish to create the property group.

Modifying a Property Group 
Customization Editor enables you tomodify property groups.

To edit a property group:

1. Open the property group editor.
2. In the Property Group Editor, make any changes you want.

For a description of the Property Group Editor, see "Property Group Editor " on page 44.
3. Press Ctrl+S to save your changes.
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Chapter 6: Creating and Using Components 
Customization Editor enables you to create custom components, for use in the customizable HPE EM user
interface.

To create and use components:

1. Create a new extension project, selectingDevelop JSPs, and setting the appropriate application server
settings.
For details, see as described in “Creating an Extension Project”.

2. Create a component.
For details, see “Creating a Component”.

3. Create a task to use your component.
For details, see “Creating a Task”.

4. Develop the Java and JSP that the component uses.
For details, see “Developing a Component”.

5. Deploy the code extension to HPE EM.
For details, see "Deploying Extensions " on page 32.

6. Perform the appropriate UI customization to use your component in HPE EM.

Creating a Component 
Components are functional elements that you can call using a number of different elements in the HPE EM
UI.

To create a component:

1. Do one of the following:
l In the Extension Explorer, open the context menu for the Components branch and select New
Component.

l In the Components Editor, click Add.

The New Component dialog box opens.
2. In the New Component dialog box, add the parameters you want.

For parameter definitions, see “New Component”.
3. Click Finish to create the component.

Creating a Task 
Tasks are top level components accessible via their URIs. The addition of a URI allows you to access the
component in the HPE EMUI, and tomakemore sophisticatedmulti-layered components.
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To create a task:

1. Do one of the following:
l In the Extension Explorer, open the context menu for the Tasks branch and select New Task.

l In the Tasks editor, click Add.

The New Task dialog box opens.
2. In the New Task dialog box, add the parameters you want.

For parameter descriptions, see “New Task”.
3. Click Finish to create the task.

Developing a Component 
When you create a component, as described in "Creating a Component " on the previous page, the templates
for the Java class and JSP page are created automatically.

To view this code, switch to the Java or Debug perspective, as shown in “Debug Perspective”.

The project contains two source folders containing the Java and JSP files, respectively.

To open an edit view, double-click the source file you want to edit. In the edit view, you can write a custom
component.
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Chapter 7: Modifying Taxonomies 
Customization Editor controls which taxonomies are available in the extension project. You can create and
modify taxonomies from your extension project.

Creating andmodifying taxonomies uses the Taxonomy Editor functionality.

For details, see theHPE EM Taxonomy Editor Guide.

To control taxonomies in your extension project:

1. In the Extension Explorer, double-click the Taxonomies branch to open the Taxonomies editor.
2. Tomodify the available taxonomies in your extension project, do one of the following:

l Open the taxonomy from the extension project, and edit the parameters as required.
Themodified taxonomy is then indicated by a > next to the taxonomy.

l To import taxonomies from HPE EM and add them to the extension, click Import. Select multiple
taxonomies by holdingCtrl.
You can also import taxonomies in the Server Explorer view. For more details, see "Server Explorer "
on page 13.

l To update taxonomies in your extension to newer versions from HPE EM, click Update. Select
multiple taxonomies by holdingCtrl.
Alternatively, in the Extension Explorer, expand the branches in the Taxonomy branch, select the
taxonomy (useCtrl to select multiple taxonomies), open the context menu, and select Update
Taxonomy.
The selected taxonomies are added as separate items for modification under the Taxonomy branch.

l To remove a taxonomy from the extension, select the taxonomy and click Remove. Select multiple
taxonomies by holdingCtrl.
To enable the import or update of taxonomies from HPE EM, youmust specify the correct server
URL during configuration.
For details, see "Creating an Extension Project " on page 19.

You can change the taxonomy in a taxonomy based property descriptor which is used in the current extension
project.

To change the taxonomy in a taxonomy based property descriptor:

1. In the treemenu of Extension Explorer, expandSDM Details > Taxonomy Property Descriptors and
double-click the descriptor you need to open its Editor in the Overview tab.

2. In the Taxonomy Name field, click Browse.
3. Select the taxonomy you want, and click Select.

The new taxonomy overrides the previous taxonomy in the property descriptor.
You cannot change the taxonomy in a taxonomy based property descriptor if the extension project is in
productionmode.
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Chapter 8: Deploying Extensions 
Deploying an extension to HPE EM is a three-part process:

1. "Exporting the Extension Project " below
2. "Applying Extensions " below
3. "Redeploying the EAR File " on page 35
4. "Deploying Components to HPE EM " on page 35
5. "Deploying Extensions Remotely" on page 35
Alternatively, if you are developing components in Customization Editor, you can directly deploy an extension
from Customization Editor.

Exporting the Extension Project 
Customization Editor displays the entire configuration of your extension plus other extensions it depends on.
However, your extension consists only of any modifications and additions that you havemade. Only these
changes are stored when you save your project as an extension JAR file, and only these changes are
deployed to HPE EM.

To create your extension package:

1. In the Extension Explorer, open the context menu of the extension name, and select HPE Enterprise
Maps > Build Extension.
The Export Extension dialog box opens.

2. Choose a save location and file name, and then click Save.
By default, the Extension Folder set during configuration is selected.
For configuration details, see "Creating an Extension Project " on page 19
If the extension already exists, Customization Editor prompts you to confirm that you want to overwrite
it.

Applying Extensions 
You can extend HPE EM by adding libraries or JSPs to the deployed EAR files, by modifying the datamodel,
by configuring the appearance of the UI, and by importing prepackaged data.

Extensions to HPE EM come from the following sources:

l Customization Editor
Typical extensions created by Customization Editor contain modifications to the datamodel and artifact
appearance, and possibly data required by the customization (taxonomies). They may also contain new
web components, whichmay include custom JSP and Java code.
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If your extension contains new artifact types, HPE EM does not create default ACLs for them. Set default
ACLs for the new artifact types in HPE EM.

l Assertion Editor, Report Editor, and Taxonomy Editor
These extensions contain assertion, reporting, and taxonomy data only. They do not involve changes to
the datamodel.

The Setup Tool opens the EAR files, applies the extensions, and then repacks the EAR files.

Apply extensions according to one of the following scenarios:

l "Single-Step Scenario " below
The Setup Tool performs all the processes involved in applying extensions, including any database
alterations, as a single step.

l "Decoupled DB Scenario " on the next page
Database SQL scripts are runmanually. The Setup Tool performs the other processes as individual steps
that are executable on demand. This scenario is useful in organizations where the user applying
extensions does not have the right to alter the database, which is done by a database administrator.

Caution: In some specific circumstances (underscores and numbers in property names), extension
applicationmay fail because HPE EM cannot create short enough database table names (31
character maximum for most databases).

The error in setup.log resembles the following:

[java] --- Nested Exception ---
[java] java.lang.RuntimeException: cannot reduce length of identifier

'ry_c_es_Artifact02s_c_priEspPty01Group_c_priEspPty01',
rename identifier elements or improve the squeezing algorithm

[java] at com.em.platform.rdbms.design.decomposition.naming.impl.
BlizzardNameProviderImpl.getUniqueLimitedLengthName(

BlizzardNameProviderImpl.java:432)
[java] at com.em.platform.rdbms.design.decomposition.naming.impl.

BlizzardNameProviderImpl.filterTableName(BlizzardNameProviderImpl.java:374)

If you do not require backward compatibility with these older versions, you can change the table naming
algorithm.
To change the table naming algorithm:

1. Open EM_HOME/lib/pl-repository-old.jar#META-INF/rdbPlatformContext.xmlwith a text
editor.

2. In the rdb-nameProvider bean element, edit the following property element:
<property name="platform250Compatible" value="false"/>

3. Save rdbPlatformContext.xml

Caution: This solution only impacts properties with multiple cardinality. If the problem persists,
then review the property naming conventions in your extension.

Single-Step Scenario 
Follow this scenario if you have permission to alter the database used for HPE EM.
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To apply extensions to HPE EM in a single step:

1. Make sure that all extensions are in the following directory:
EM_HOME/extensions

The Setup Tool automatically applies all extensions in that directory.
If you are applying extensions to another server, substitute the relevant home directory for EM_HOME

2. Stop the server.
3. Start the Setup Tool by executing the following command:

EM_HOME/bin/setup.bat(sh)
4. Select theApply Extensions scenario, and click Next.

The Setup Tool automatically validates the step by connecting to the server, copying the extensions,
andmerging the SDM configuration.

5. Click Next for each of the validation steps and the setup execution.
This process takes some time.

6. Click Finish to end the process.
7. Deploy the EAR file:

The Setup Tool deploys the EAR file automatically.
If you need to deploy the EAR file to JBoss manually, see Redeploying the EAR File.

8. Restart the server.

Caution: Applying an extension that modifies the SDMmodel may drop your full text indices.

EM_HOME/log/setup.log contains the following line in these cases:

Could not apply alteration scripts, application will continue with slower DB
drop/create/restore scenario. ... .

In these cases, reapply full text indices.

Decoupled DB Scenario 
Follow this scenario if the user who applies extensions does not have permission tomodify the database.

To apply extensions and modify the database separately:

1. Make sure that all extensions are in the following directory:
EM_HOME/extensions

The Setup Tool automatically applies all extensions in that directory.
2. Stop the server.
3. Start the Setup Tool by executing the following command:

EM_HOME/bin/setup -a.
4. Select theApply Extensions scenario, and click Next.
5. Click Next, to execute the extension application, and exit the Setup Tool.
6. Provide the scripts from EM_HOME/sql to the database administrator.

The database administrator can use all.sql to execute the scripts that drop and recreate the database
schema.
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7. Execute the Setup Tool in command-linemode to finish the extension application:
EM_HOME/bin/setup -c

8. Redeploy the EAR file:
The Setup Tool deploys the EAR file automatically.
If you need to deploy the EAR file to JBoss manually, see Redeploying the EAR File.

Redeploying the EAR File 
After using the Setup Tool to apply extensions or updates, youmust redeploy the EAR file to the application
server. For JBoss, you can do this using the Setup Tool.

To redeploy the EAR file to JBoss:

1. Stop the application server.
2. Start the Setup Tool by executing the following command:

EM_HOME/bin/setup.bat(sh).
3. Select theAdvanced scenario, and click Next.
4. Scroll down, select Deployment, and then click Next.

When the Setup Tool validates the existence of the JBoss Deployment folder, click Next.
5. Click Finish to close the Setup Tool.
6. Restart the application server.

Deploying Components to HPE EM 
If you are creating components in Customization Editor, it is not convenient to continually build and apply
extensions to HPE EM. Customization Editor enables you to deploy your extension directly to HPE EM.

Only HPE EM deployed to a JBoss application server is supported by this release.

To directly deploy an extension from Customization Editor:

1. Stop the application server.
2. Switch to the Debug perspective in Customization Editor.
3. From themainmenu, select Run > External Tools > Open External Tools Dialog.

The External Tools dialog box opens.
4. Select Ant Build > Customization Editor – Apply Extension.
5. Click Run to apply the extension.
The Console view displays the output of the deployment process.

Deploying Extensions Remotely
In addition tomanual deployment, you can deploy an extension remotely fromWorkbench to EM server.

To do so, follow the steps below:
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1. Open the extension project.
2. In the Extension Explorer, open the context menu of the extension name , and select HPE Enterprise

Maps > Apply Extension on Server.
3. Follow the subsequent screens to deploy the extension to EM server.

Note: Remote deployment requires administrative rights. Thus, you are prompted to provide
administrative credentials.
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Chapter 9: Views 
Each Customization Editor view in themain and bottom-right section of the editor is described in the following
sections:

l "Artifact Editor " below. Manage your SOA artifacts and customize their properties, appearance, and
registry mapping.

l "Messages View " on page 40. View the action log as you customize your extension project.
l "Project Editor " on page 40. Manage your extension project.
l "Property Editor " on page 42. Manage your SOA properties and which perspectives can see and edit them.
l "Property Group Editor " on page 44. Organize your properties into groups.
l "Search View " on page 44. View the results of usage and entity searches.
l "Tasks Editor " on page 45. Manage tasks in HPE EM.
l "Taxonomies Editor " on page 45. Customize the taxonomies available in HPE EM.

Artifact Editor 
Artifacts are the basic building blocks of SOA and represent all types of entity. This editor enables you to
modify the parameters, and properties of an artifact type within HPE EM. Each artifact type and package has
an editor with the artifact name as the title.

Each editor contains the following tabs described in the following sections:

l "Artifact Editor: Overview Tab " below
Themain attributes of the artifact type.

l "Artifact Editor: Properties Tab " on the next page
The properties of the artifact type.

l "Artifact Editor: Registry Mapping Tab " on page 39
Themapping of the artifact to registry entities.

Artifact Editor: Overview Tab 
TheOverview tab displays the general attributes of the artifact and allows you tomodify some of them.

TheOverview tab contains the following segments:

l Artifact General Information. The following parameters related to artifacts shown in this pane. They are
described in the table below:

Parameter Definition

URI The identifier for the artifact descriptor in the configuration.
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Parameter Definition

Display Name The name of the artifact as it appears in the HPE EMUI.

Local Name The name of the artifact as it is stored in the extension.

Collection
Display Name

The plural version of the name as it appears in the HPE EMUI.

Artifact Icon Displays the icon used for the artifact in the UI with an option to change it.

Package The parent artifact type that this artifact type belongs to.

Extends Type The artifact type that this artifact type inherits the properties of.

Description The description of the artifact type as it appears in the HPE EMUI.

Deprecated A check box indicating whether the artifact is currently active in the extension.

Revisionless Indicates whether the artifact creates a new revision when it updates.

Abstract A check box indicating whether the artifact is an artifact package which does not
have actual instances in the repository.

Data Attachment Indicates the type of data content that may be attached to the artifact.

l Properties
A summary of the different properties that the artifact has. Each of the links opens theProperties tab
described in "Artifact Editor: Properties Tab " below.

Artifact Editor: Properties Tab 
TheProperties tab displays all the properties of the artifact and enables you to add and remove them:

This tab contains the following panes:

l Properties
This is the list of individual properties of the artifact. On the right are the following buttons:
l New opens theNew Property dialog described in "Creating a Property " on page 27.

l Add adds a property to the artifact type from the list of available property descriptors, set its cardinality,
and its location on theView Artifact page.

l Deprecate deactivates the property in the artifact type.

l Undeprecate reactivates the property in the artifact type.

l Remove removes the selected property from the artifact type.

l Property Groups
This is the list of the property groups of the artifact. On the right are the following buttons:
l New opens theNew Property Group dialog. For details, see "Creating a Property Group " on page 28.
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l Add adds a property group to the artifact type from the list of available property groups.

l Remove removes the selected property group from the artifact type.

l Inherited Groups and Properties
If the artifact is based on another artifact then this segment displays the inherited artifact and its properties
and groups.

The following property parameters are displayed in these panes:

Parameter Definition

Name The name of the property as it appears in the HPE EMUI.

Cardinality The occurrence of the property in an artifact with options:
l Optional
The property is not required to be populated.

l Required
The property must be populated.

l Multiple
The cardinality is determined by theMinOccurs/MaxOccurs defined in the Property Editor:
Advanced Tab. For details, see "Property Editor: Advanced Tab " on page 43.

Extension Which extension this property is part of.

Artifact Editor: Registry Mapping Tab 
TheRegistry Mapping tab displays any mappings between the artifact and entities in registries and allows
you to create, edit, and remove them:

It is split into the following panes:

l Artifact Mapping
This is the list of registry entities that represent the artifact in registries. On the right are the following
buttons:
l Add adds a registry mapping, as described in "Mapping an Artifact Type to a Registry " on page 24

l Edit edits themapping, as described in "Mapping an Artifact Type to a Registry " on page 24

l Remove removes themapping from the artifact.

The following registry mapping parameters are displayed in this pane:

Parameter Definition

Registry Name The registry that the artifact type is mapped to.

TModel Key The taxonomy key used to categorize the UDDI entity in the registry.
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Parameter Definition

Key Name The name used to categorize the UDDI entity in the registry.

Key Value The value used to categorize the UDDI entity in the registry.

Extension Which extension this mapping is part of.

l Property Mappings
This is the list of the properties of the artifact and if they aremapped to a registry. On the right are the
following buttons:
l Add adds a new registry mapping for the selected property, as described in"Mapping an Artifact Type
to a Registry " on page 24.

l Edit edits a property mapping, as described in "Mapping an Artifact Type to a Registry " on page 24

l Remove removes amapping from the selected property.

The following registry mapping parameters are displayed in this pane:

Parameter Definition

Property Name The name of the property.

Registry Name The registry that the artifact type property is mapped to.

TModel Key The taxonomy key used to categorize the UDDI entity in the registry.

Key Name The name used to categorize the UDDI entity in the registry.

Extension Which extension this property is part of.

Messages View 
TheMessages view tracks the changes that youmake to extension entities and displays any warnings and
problems that may occur as a result of those actions:

Double-clicking an item in the tree opens the relevant editor for that object.

Project Editor 
The project editor allows you to configure your extension project. It contains three tabs described in the
following sections:

l "Project Editor: Overview Tab " below
l "Project Editor: Environment Tab " on the next page
l "Project Editor: Dependencies Tab " on the next page

Project Editor: Overview Tab 
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TheOverview tab enables you to view and amend the basic parameters of your extension project:

TheOverview tab contains the following collapsible panes:

l Project details displays parameters for the extension project:

Parameter Definition

Project name The name of the extension project.

Project type The project is an extension project.

Project location The workspace folder that contains the extension project.

Last modified The last time the project was changed.

l Extension details enables you to configure some of the extension project parameters:

Parameter Definition

Name The display name of the extension.

Version The version number of the extension project.

Description A description of the extension project.

URI The identifier for the extension in the configuration (not editable).

Namespace The prefix used for the URI when you create a new artifact type or property.

Project Editor: Environment Tab 
TheEnvironment tab displays the parameters of the HPE EM server that the Customization Editor is
configured for:

TheEnvironment tab contains the following parameters:

Parameter Definition

Platform Home Your HPE EM installation folder.

Extension Folder The location of the extension folder in your HPE EM installation.

Server URL The URL used to access HPE EM.

Deploy JSPs Indicates if component and JSP development is configured for your extension
project.

JBoss Deploy
Directory

Deployment directory for your JBoss application server.

JBoss JNDI Port JNDI port configured in your JBoss application server.

Project Editor: Dependencies Tab 
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TheDependencies tab displays general information about your extension project and any dependencies that
is has:

TheDependencies tab contains the following panes:

l Extension dependencies displays a tree of extensions that the extension project is dependent on.
l Project and extension general information displays parameters of the extension project:

Parameter Definition

Name The name of the extension.

Version The version number of the extension project.

Description A description of the extension project.

URI The identifier for the extension project in the configuration (not editable).

Buildtime The creation date and time of the extension.

Property Editor 
Properties are attributes of artifacts. The property editor allows you tomodify the properties in your extension
project. Each property has an editor with the property name as the title containing the tabs described in the
following sections:

l "Property Editor: Overview Tab " below
Themain attributes of the property.

l "Property Editor: Advanced Tab " on the next page
The advanced attributes of the property.

Property Editor: Overview Tab 
TheOverview tab displays the general attributes of the artifact and enables you tomodify some of them:

This tab contains the following panes:

l General
The following property parameters are displayed in this segment:

Parameter Definition

Display Name The name of the property as it appears in the HPE EMUI.

Local Name The name of the property as it is stored in the extension.

URI The identifier for the property descriptor in the configuration.

Description The description of the property as it appears in the HPE EMUI.

Collection Display The plural version of the name as it appears in the HPE EMUI.
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Parameter Definition

Name

Deprecated A check box indicating whether the property is currently active in the
extension.

l Property Type, Relationship, or Taxonomy
There are three types of property and this segment is specific to each:
l Property Type
The property type for primitive properties.

l Relationship
This pane displays the source and target artifacts that this relationship links and some parameters of
the inverse relationship. On the right are two sets of two buttons for altering the source and target
artifacts:
o Add selects an artifact in the extension to source or target.
o Remove removes the relationship from a source or target artifact.

l Taxonomy
The taxonomy that contains the available options for this property withBrowse to select a new
taxonomy from the extension project.

Property Editor: Advanced Tab 
TheAdvanced tab displays the advanced attributes of the property and allows you tomodify them:

This tab contains the following panes:

Multiple Cardinality:

Parameter Definition

MinOccurs If a property has multiple cardinality this parameter is theminimum occurrences of the
property in an artifact.

MaxOccurs If a property has multiple cardinality this parameter is themaximum occurrences of the
property in an artifact. Use unbounded if there is no limit.

Caution: Properties that inherit urn:com:systinet:soa:model:propertyTypes:text, such as Name,
cannot havemultiple instances. If you need a text property with multiple cardinality, use one that inherits
urn:com:systinet:soa:model:propertyTypes:plainText.

Note: Cardinality for incoming relationship properties cannot be changed.
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l Default Values:

Parameter Definition

Default Value An XML extract defining the default value.

Multiple Default Value An XML extract defining default values in the case of multiple cardinality.

l Database Sizes
Displays optional database sizing for property elements withAdd, Edit, andRemove functionality.

Property Group Editor 
Properties can be organized into groups. The property group editor allows you to add and remove properties
from a property group. Each property group has an editor with the property group name as the title.

The editor contains the following collapsible segments:

l General enables you to change theDisplay Name and view theURI of the property group.
l Properties enables you tomanage the property group.
On the right are three buttons:
l New creates a new property, as described in "Creating a Property Group " on page 28.

l Add adds a property to the group from the list of available properties.

l Remove removes the selected property from this property group.

The following property parameters are displayed and described in the table below:

Parameter Definition

Name The name of the property.

Cardinality The occurrence of the property in an artifact with options:
l Optional
The property is not required to be populated.

l Required
The property must be populated.

l Multiple
The property can occur multiple times with different
values.

Extension The extension this property is part of.

Search View 
TheSearch view displays the results of a search or find usage query:
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The results are shown as a tree of artifact types, properties, and property groups containing the requested
item.

Double-click an artifact type, property, or group to open the relevant editor.

Tasks Editor 
Tasks are top level HPE EMUI components accessible via their URIs. The tasks editor allows you to create,
edit, and remove tasks from your extension project.

On the right are the following buttons:

l New opens theNew Task dialog box, as described in "Creating a Task " on page 29.
l Edit opens theEdit Task dialog box with the same parameters described in "Creating a Task " on page 29
l Remove deletes the selected task from your extension project.
The following parameters relate to tasks:

Parameter Definition

URI The identifier for the task.

Component The component the task uses.

Caption A name for the task.

Extension Which extension this task is part of.

Taxonomies Editor 
Taxonomies are category groups that allow you to organize your services. The taxonomies editor allows the
import and removal of taxonomies from your extension project.

On the right are the following buttons:

l Import imports taxonomies from the active HPE EM server.
The referenced HPE EM server must be running during import.

l Update refreshes the taxonomy list with any changes from the HPE EM server.
l Remove deletes the selected taxonomy from the extension project.
The following parameters relate to taxonomies:

Parameter Definition

Name The name of the taxonomy as it is stored in the extension.

TModel Key The taxonomy key identifier.

Extension Which extension this taxonomy is part of.
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Appendix A: Dialog Boxes 
Each Customization Editor input dialog is described in the following sections:

l "New Artifact " below: Create a new artifact type or package.
l "New Component " on the next page: Create a new component.
l "New Extension Project " on the next page: Create an extension project.
l "New Property " on page 50: Create a new property.
l "New Property Group " on page 51: Create a new property group.
l "New Task " on page 52: Create a new task.
l "Registry Mapping " on page 52: Add registry mapping.
l "Search " on page 53: Search your extension project.

New Artifact 
The New Artifact Type and New Artifact Package dialogs are identical and consist of the following ordered
stages:

1. "New Artifact: Create " below
2. "New Artifact: Database Settings " on the next page

NewArtifact: Create 
Enter general parameters of the new artifact type.

Parameter Definition

Display
Name

The name of the artifact as it appears in the HPE EMUI.

Local Name The name of the artifact as it is stored in the extension.

URI The identifier of the artifact descriptor in the configuration.

Collection
Display
Name

The plural name of the artifact as it appears in the HPE EMMUI.

Package Click Browse to select a parent artifact package to which the artifact belongs. The default
is EM if the new artifact is not created from within an existing artifact package.

Extends If you select Extends, the new artifact inherits any future changes made to the chosen
parent artifact.

Click Browse to select an artifact type to inherit the properties from
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Parameter Definition

Description The description of the artifact type as it appears in the HPE EMUI.

Data
Attachment

If the artifact type normally has attached data content, select the content type from the
drop-down list.

Revisionless Specify the artifact to be revisionless. These type of artifacts update without creating a new
revision.

NewArtifact: Database Settings 
Specify database settings for the new artifact type.

Parameter Definition

Collection name The name of collection where the artifact instances are stored

Database table name The name of the database table where instances of this artifact are stored

Note: You cannot change these parameters if the new artifact extends an artifact type that already defines
them.

New Component 
Enter general parameters for the new component.

Parameter Definition

Name The name of the component as it is stored in the extension.

Page The JSP used by the component.

Class name The Java class used by the component.

Component parameters UseAdd andRemove to select parameters to use with the component.

New Extension Project 
The New Extension Project dialog consists of the following stages depending on the options you select:

1. "New Extension Project: Specify HPE EM Server Installation " on the next page
2. "New Extension Project: New Server " on the next page
3. "New Project: Select Working Extensions " on page 49
4. "New Project: Create a New Extension " on page 49
5. "New Project: Create Dependencies " on page 49
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New Extension Project: Specify HPE EM Server Installation 
Specify configuration details for an HPE EM server.

Parameter Definition

Base URL EM base URL. For example: http://localhost:8080/em.

Username /
Password

Admin credentials to connect to EM.

Platform Home UseBrowse to select the HPE EM platform installation folder. If
Workbench is installed on a different machine other than the EM
server, simply select an empty folder.

Extension Folder UseBrowse to select the extension folder in your HPE EM
installation (populated by default based on thePlatform Home
input. If Workbench is installed on a different machine other than
the EM server, copy the core extension file from HPE EM
installation folder (usually in EM_HOME/extensions/) to this folder.

ProductionMode Select this check-box to create the project in productionmode
(selected by default). This disables customizations that would
require the deletion of server data during the application of the
extension to HPE EM.

Project Type Select from the following options:
l model for changes to the SDMmodel.
l code for custom code components and UI customizations.
l mixed for both types of changes (not recommended).

JBoss Deploy
Directory

UseBrowse to select the deployment directory for your application
server (usually JBOSS_HOME\standalone\deployments)

JBoss JNDI Port Input the JNDI Port for your application server.

Only JBoss is supported for the development of components and tasks in this release.

New Extension Project: New Server 
Specify parameters for the new server.

Parameter Definition

Name The name you want to use for the new server.

URL The endpoint URL of the server you want to use.

Username and
Password

Your login credentials for the specified server.

Save password Select this check-box to store your login credentials.
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Parameter Definition

Validate
connection

Select this check-box to validate connection to the server. Otherwise, you can validate
connection the next time you log in.

NewProject: Select Working Extensions 
Choose how to create your working extensions.

Selection Action

Create a new extension from
scratch

Click Next.

Edit an existing extension Do one of the following:
l Select from the available extensions and click Next.
l Click Add extension to browse for and select a different
extension, and click Next.
You cannot edit the core extension

Create a new extension from an
existing one

Do one of the following:
l Select from the available extensions and click Next.
You cannot use the core extensions.

l Click Add extension to browse for and select a different
extension, and click Next.

NewProject: Create a New Extension 
Enter general parameters for the new extension.

Parameter Definition

Name The name of your extension project

Namespace The prefix used for the URI when creating a new artifact type or property

Description A description of your extension project

Version The extension version number

URI The unique identifier of the extension

NewProject: Create Dependencies 
Select extensions to declare dependencies.
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Tip: Your changes are stored in your extension. You can change the labels and descriptions of elements from
dependent extensions but you cannot delete them ormake any other changes. If you want to delete an
element from a dependent extension then deprecate it.

New Property 
The New Property dialog contains parameters according to the property type:

l "New Property: Primitive " below
l "New Property: Relationship " below
l "New Property: Taxonomy " on the next page
For details about property types, see "Properties " on page 14.

NewProperty: Primitive 
Enter general parameters for the new primitive property.

Parameter Definition

Display Name The name of the property as it appears in the HPE EMUI

Local Name The name of the property as it is stored in the extension

URI The identifier for property in the configuration

Collection
Display Name

The plural name of the property as it appears in the HPE EMUI

Description The description of the property as it appears in the HPE EMUI

Property Type UseBrowse to select a property from the available primitive property types. For
details, see "Properties " on page 14.

NewProperty: Relationship 
Enter general parameters for the new relationship property.

Parameter Definition

Display Name The name of the property as it appears in the HPE EMUI

Local Name The name of the property as it is stored in the extension

URI The identifier for the property in the configuration

Collection Display Name The plural name of the property as it appears in the HPE EMUI

Description The description of the property as it appears in the HPE EMUI
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Parameter Definition

Relation Type Select a type from the drop-down list

From Entity UseBrowse to select the source artifact type or property group of the
relationship

To Entity UseBrowse to select the target artifact type or property group of the
relationship

Inverse Display Name The name of the inverse relationship property as it appears in the HPE EM
UI

Inverse Local Name The name of the inverse relationship property as it is stored in the
extension

Inverse URI The identifier for the inverse property descriptor in the configuration

Inverse Collection Display
Name

The plural name of the inverse relationship property as it appears in the
HPE EMUI

Inverse Relationship
Description

The description of the inverse relationship property as it appears in the
HPE EMUI

NewProperty: Taxonomy 
Enter general parameters for the new taxonomy property.

Parameter Definition

Display
Name

The name of the property as it appears in the HPE EMUI

Local Name The name of the property as it is stored in the extension

URI The identifier for the property in the configuration

Collection
Display
Name

The plural name of the property as it appears in the HPE EMUI

Description The description of the property as it appears in the HPE EMUI

Taxonomy UseBrowse to select a taxonomy from the available taxonomies with an option to import
taxonomies available in HPE EM that are not in your extension.

New Property Group 
Enter general parameters for the new property group.
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Parameter Definition

Display Name The name of the property group as it appears in the HPE EMUI

URI The identifier for the property group descriptor in the configuration

Properties UseAdd andRemove to select the properties in the group

New Task 
Enter general parameters for the new task.

Parameter Definition

Uri The identifier for the task

Component UseBrowse to select the component to associate with the task

Caption A visible name for the task.

Task parameters UseAdd andRemove to select parameters to use with the task

New Taxonomy 
Enter general parameters for the new taxonomy.

Parameter Definition

Taxonomy Name The name of the new taxonomy as it will appear in the HPE EMUI.

Taxonomy ID The system identifier of the new taxonomy.

Filename The name of the taxonomy as it appears in the repository.

Registry Mapping 
l "Registry Mapping: New Artifact Mapping " below
l "Registry Mapping: New Property Mapping " on the next page

Registry Mapping: New Artifact Mapping 
Enter parameters for the new registry mapping of the artifact.

Parameter Definition

Registry UseSelect to select from the available registries
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Parameter Definition

T-ModelKey UseAdd to select from the available taxonomies or input one

T-ModelKey
version 2

If you aremapping to a UDDI version 2 registry input a taxonomy key

Key Name The name used to categorize the UDDI entity in the registry

Key Value The value used to categorize the tModel in the registry

Display Name The name of themapping as it appears in the HPE EMUI

Cache content If selected, the content of documents referenced from the UDDI entity are cached in
HPE EM

Direction Select the direction of themapping from the drop-down list

Registry Mapping: New Property Mapping 
Enter parameters for the new registry mapping of the property.

Parameter Definition

Property UseSelect to select from the available properties

Direction Select the direction of themapping from the drop-down list

Registry UseSelect to select from the available registries

T-ModelKey UseAdd to select from the available taxonomies or input one

T-ModelKey version 2 If you aremapping to a UDDI version 2 registry input a taxonomy key

Key Name The name used to categorize the UDDI entity in the registry

Search 
Enter parameters to search your extension project.

Parameter Definition

Containing
text

The parameter to search for

Case
sensitive

Check the box tomake the search case sensitive

Regular
expression

Enables more sophisticated search parameters (for example, to find everything with more
than one word). This is an advanced topic beyond the scope of this guide.
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Parameter Definition

Search For Select the SDM entities to search

Search In Select the entity attributes to search

Scope Select the extension to search

Share Project 
Define parameters for the CVS repository.

Parameter Definition

Host The name of the host server.

Repository path The location of the host server.

User and Password Your login credentials for the host server.

Connection type The communication protocol for the CVS host server.
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Appendix B: Localname Naming Rules 
The naming strategy used to generate the names of database tables and columns can only process a specific
subset of XML identifiers (element and attribute names). This is because the existing database engines have
limits for the length of tablename/columnname identifiers. XML identifiers are generated from the SDM
configuration in a straightforward way. This section omits the XML layer for simplicity and summarizes the
rules at the SDM level which is more user-friendly.

When creating an artifact type or property, for the localname, do the following:

l Use Latin characters where possible (A-Z, a-z)
l Use short identifiers where possible to improve the readabililty of the DB schema. For example,

stSchtronXslt is a better localname than searchAndTransformSchematronXsltUrlLink.
l You can safely use underscores in localnames.
Do not use numbers in localnames where possible. They should not be used in artifact localnames at all
and to avoid confusion, do not use numbers in property localnames when the property is in multiple
cardinality.
Using numbers in localnames increases the chances that extension application fails.
There are no restrictions on property group localnames as they are not represented in the database
schema.
It is difficult to generate separate validation rules for properties and artifacts because the generated DB
identifiers are often influenced by a combination of both.
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